Introduction

The Bare-Bones Board has been engineered to be a low-cost easy-to-construct Arduino, specially aimed at students and prototypers. The board plugs into a breadboard, and has several convenient features that make it easy to use for both beginning and advanced prototyping.

Despite its title, the Bare-Bones Board includes all of the functionality of the most robust Arduino boards, and even some recommended analog noise-reducing components not found on any of the Arduino reference designs.

The boards and kits, which have been engineered to be as flexible as possible for widely varied types of prototype designs, can be built in an hour by a beginner at soldering, or in a half-hour by someone who has built a few of them before.

Only a low-wattage soldering iron (15 - 25 Watts), and solder is required. Small size alligator clips and desoldering braid may make the job easier or quicker.

Assembly Instructions - getting started

For beginners that have never done electrical soldering before see the Soldering section before starting. There are a few tips for multiple-unit "power builders" too.

Start assembling the board with the smallest, lowest profile components first. That way taller components will not get in the way when trying to install smaller components. Also when parts are inserted, and the board is flipped over to solder, components will tend to stay in the board better, if similar, lower-profile components are inserted first.

Read, and be certain about, which components are polarized, before you insert them. Polarized components include the diodes, LED, two electrolytic capacitors and the IC (chip) socket. All others are not polarized and can be inserted in either direction.

Assembly Instructions - step by step procedure

• The first component to deal with is the smallest, the 15 uH surface-mount inductor, marked "150". This inductor provides a small amount of analog (A/D) noise reduction, it is recommended in the Atmega168 datasheet, but is not included in other Arduino implementations. If you do not wish to deal with the small surface mount component you may just solder up (short circuit) the surface mount pads.

Parts List

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inductor</td>
<td>15 uH surface-mount inductor</td>
</tr>
<tr>
<td>Resistors, 1/4W</td>
<td>2 10k (brown - black - orange)</td>
</tr>
<tr>
<td></td>
<td>1 1k    (brown - black - red)</td>
</tr>
<tr>
<td>Capacitors</td>
<td>5 .1ufd (104) ceramic, 25 V</td>
</tr>
<tr>
<td></td>
<td>2 4.7-47 ufd tantalum or electrolytic capacitors (polarized), 25V</td>
</tr>
<tr>
<td>Semiconductors</td>
<td>2 1N400x 1amp power diodes</td>
</tr>
<tr>
<td></td>
<td>1 L4931CZ50LDO 5V, low-dropout voltage regulator, TO-92 package</td>
</tr>
<tr>
<td></td>
<td>optional - TO-220 packages</td>
</tr>
<tr>
<td></td>
<td>2 LM2940 1A LDO regulator OR LM7805 1A regulator</td>
</tr>
<tr>
<td></td>
<td>1 3mm (T1) green LED</td>
</tr>
<tr>
<td></td>
<td>1 Atmega168 / 328, 28 pin DIP package preprogrammed with bootloader</td>
</tr>
<tr>
<td></td>
<td>1 16 Mhz ceramic resonator with built-in capacitors, three-terminal SIP package</td>
</tr>
<tr>
<td></td>
<td>optional - 16 Mhz crystal HC49 package with capacitors, 0503 surface mount package</td>
</tr>
<tr>
<td>Hardware</td>
<td>Male Headers, .100&quot; centers</td>
</tr>
<tr>
<td></td>
<td>3 x 7 for analog block (optional - provided in kit)</td>
</tr>
<tr>
<td></td>
<td>2 1x2</td>
</tr>
<tr>
<td></td>
<td>1 3x3</td>
</tr>
<tr>
<td></td>
<td>1x18</td>
</tr>
<tr>
<td></td>
<td>1 x6 right angle for BUB/cable header</td>
</tr>
<tr>
<td>Female Headers, .100&quot; centers</td>
<td>3 x7 for analog block</td>
</tr>
<tr>
<td></td>
<td>1 momentary switch</td>
</tr>
<tr>
<td></td>
<td>1 28 pin (narrow - .3&quot;) IC socket</td>
</tr>
<tr>
<td></td>
<td>2 .100&quot; header 2 position shorting clip (shunt)</td>
</tr>
<tr>
<td></td>
<td>1 2.1mm power jack</td>
</tr>
<tr>
<td>Accessories</td>
<td>Programming Adapters</td>
</tr>
<tr>
<td></td>
<td>USB-BUB, moderndevice.com OR FTDI TTL-232R programming cable mouser.com</td>
</tr>
<tr>
<td></td>
<td>Power Supply</td>
</tr>
<tr>
<td></td>
<td>5 Volt - 1A power adapter w 2.1mm plug</td>
</tr>
<tr>
<td></td>
<td>digikey.com T1038-PSRP-ND</td>
</tr>
</tbody>
</table>
where it was to be mounted. If you do decide to mount the surface-mount inductor there are soldering tips on page 4.

• Solder in two 10 k resistors, a 1 k resistor, two diodes, and five small 1 uf ceramic capacitors, one LED, one reset switch, and the voltage regulator. The diodes, LED, and voltage regulator are polarized and must be inserted in the correct orientation. The diodes have a stripe, which must be matched with the stripe on the board. The LED has one longer lead, which is positive and should be inserted closest to the plus sign on the board. The voltage regulator also has a shape which matches the outline on the board. See the drawings for various voltage regulator orientations. The resistors and smaller capacitors have no polarity and may be inserted in either direction.

• Mount the two 47 uF electrolytic capacitors, carefully observing the polarities and orientation of each. The long leads on the capacitors are positive and get inserted closest to the plus signs on the board.

• Insert the IC socket (not the chip) into the board, taking care to align the notch with the notch on the board silk screen.

For larger and multi-pin components, such as the chip socket and header pins, there is a little trick that may be helpful to get them mounted neatly.

Solder in one pin only, or in the case of the socket, two diagonal corner pins. Then flip the board over to inspect it. If the component is not mounted tightly down on the board, simply put a little pressure on the component with your index finger while reheating the soldered pad(s) with the soldering iron, this will get the part mounted down flush, and straight before you solder in the other pins.

• Solder in the power jack.

• Solder in the header pins. The board is made to be easy to customize for particular applications. The following instructions are for the most standard orientation for header pins, but feel free to mount (or omit them) as you wish. In some installations it may be more robust and reliable to solder wires directly to the board. A small alligator clip, such as the ones sold at Radio Shack, with the noses of the clip pinched flat, makes a great clip for holding the header pins to the board while you solder them (see photo).

• The eighteen digital header pins gets inserted into the bottom of the board and then soldered on the top side, as do the two pins, at front right, that are designed to power the breadboard rails. It is a good idea to mount these pins last after most of the other parts are mounted on the top of the board.

• All other header pins get inserted into the top of the board and soldered on the bottom.

• BBB kits are provided with both male (pins) and female (socket) headers for the 3x7 analog block. Use either male or female pins as you desire, although female headers are probably the more popular option, and we provide assembled BBB’s with that option standard.

• Finally mount the resonator (marked XTAL on board). It can be inserted either way but it’s a good idea to insert it with the label showing.

• Hobbyists and prototypers often omit this step, but it is a good idea to clean the solder flux off your board with a toothbrush and isopropyl (not denatured) alcohol. Scrub and rinse with clean alcohol until the board looks flux-free. Dry it off a little with a paper towel or rag and have a good inspection of your solder joints, to make sure pins are not bridged (shorted) with solder, and that all the solder joints look shiny, smooth, and cover the pads completely. Questionable solder joints may be fixed simply by reheating with a soldering iron.

• Add the shorting clip to the PRJ power selection header in the default USB position. There is more on the shunt’s function below.

Testing your BB Arduino

• Put the USB / EXT shorting clip on the power selector pins. Power up the board, either with the programming cable or an external supply and make sure that the pilot light goes on. If not, disconnect the power right away, and consult the troubleshooting section. Do a check with a multimeter for 5 volts at the power pins to the left end of the digital breadboard pins.

• If all seems well, disconnect the power, and insert your Atmega 168 chip into the socket, taking care to align the notch on the chip with the notch on the socket and on the board silk screen. Chips come from the factory with the legs splayed, and the chip will be much less fussy to insert if you perform the following operation: hold the chip exactly perpendicular to a table and press down until the all the legs have a 90 degree angle to the chip top. Flip, repeat, and you’re ready to put the chip into the socket.

• Next hook up an LED on pin 13 with a 1K series resistor to ground. Boot up the Arduino application and try downloading the blinking light program (File->Sketchbook->Examples->Digital->Blink)

• If your board doesn’t seem to work, see the troubleshooting guide on page 6.

Powering the BBB Arduino.

There are several options for powering the BBB. Schematic diagrams of some various power options are illustrated on page 6. Some study of these diagrams may make the choices for powering the BBB more clear.

USB is a convenient option for powering your board because it eliminates other wires and batteries and it should be viable for many projects that only involve interfacing sensors, lighting LED’s, or communicating with a laptop/desktop computer. The USB-BUB or FTDI 232R cable can supply 5 volts at up to 500 mA to the board.

The revision E version of the BBB made a change to the power system from the revision D version of the board. The USB 5V line, at the cable header, no longer runs through the voltage regulator.

A 6-12 volt power wall adapter is probably a better choice
for circuit experiments and higher current projects. This will take the strain off your laptop battery and protect more expensive systems in the case of short circuits and the like. For powering small DC motors, servos or solenoids especially, you will be much better off using an external power supply.

**PRJ shunt**

The PRJ (power rail jumper) is an option that sets how the positive power line of the BBB is connected to the positive line of the breadboard power rail pins on the right side of the board. Its only job is to control the connections to that one pin, so if you aren't using the power rail pin, the shunt’s position is immaterial. Studying the schematics on page 6 will probably make the PRJ options more clear, but here is a summary.

**Use the +5V PRJ shunt setting in the following cases:**

1) When powering the BBB from the USB-BUB or FTDI cable. In this case the USB line also conveniently provides 5 volts to the breadboard rails.

2) When powering the BBB from the breadboard power rail (*with a 5 volt regulated supply only*). With this option some form of 5 volt regulated power is applied to the breadboard power rails, which then powers the BBB.

**Use the EXT (external) shunt setting in the following cases:**

1) When powering the BBB from an external adapter, AND desiring to run the adapter's voltage into the breadboard power rails without having it go through the BBB’s voltage regulator. This might be useful for example, when powering servo motors from a six volt adapter, where the full 6 volts was useful for the motors, which were connected to the breadboard rail.

2) When powering the BBB from the power rail pins, which are connected to an external supply greater than 5 volts. In this case the higher voltage from the power rails is routed through the BBB’s voltage regulator.

The default position of the PRJ shunt should be in the 5V position.

**Support**

Please post support questions on the Modern Device Forum. We know this is a little more work than emailing us directly but it builds a database where other users can find answers to their questions. We thank you in advance for registering on the forum and asking your questions there.

**Suggestions wanted**

Please let us know if there are features you think would be handy or should be built into the BBB or are other products. Corrections and suggestions for this documentation are also highly valued and appreciated. Most will be implemented quickly.
**Tips and Tricks**

- The USB / EXT shunt makes a (somewhat) handy way to turn the power off.
- Removing the shunt is a handy way to measure current draw of the board (or a breadboard circuit) with a multimeter set to a current range. (Carefully though, if you haven't taken current readings before.)
- Voltage regulator may be swapped out with higher powered TO220 type.
- If the pilot light goes out, you have a short circuit somewhere. (more in troubleshooting section).

**Board hacks and options**

The Bare-Bones Arduino was engineered to be a small, versatile prototyping board, so depending on your circumstances, there may be several parts you can do without.

The pilot light and its associated resistor is a useful feedback signal, but if you are building a battery powered device which requires minimal power draw, for example, leave out the LED and add an LED (with series resistor) connected to an Arduino digital pin and blink the LED every 3 or four seconds, to save power.

Any of the header pins can be left out, or soldered on the top or bottom of the board, or can be replaced by female headers, (for mating with shield boards, for example). One flexible option might be to use longer, male, header pins that protrude both above, and below, the board. This would make it possible to use your BBB with either a breadboard, or a shield board.

The power jack could be left off to make the BBB a bit smaller, if the board was going to be powered in some other manner.

You could even leave out the 16 Mhz resonator, and program the Atmega168 chip to run on the internal RC oscillator, at 8 Mhz. This would require burning a new bootloader on the chip (which also requires additional hardware.) See Arduino.cc for instructions.

---

**BBB dimensions**

Dimensions of populated boards include cable header and power jack, which extend beyond outline of the pcb.
An Arduino Board set up on a solderless breadboard with six LED's ready for dimming with the PWM outputs.

Programming connections between a BBB, USB-BUB, and FTDI TTL-232R USB to TTL serial cable.

Please note that the TX and RX labels refer to the cable's labeling, not the chip's. The TX label at the programming connector is electrically connected to the BBB's RX pin (0) and the cable's RX pin is connected to the BBB's TX pin (1).

Arduino Pins

digital pins

- digital pin 0 (RX) (PCINT16/RXD) PD0 2
- digital pin 1 (TX) (PCINT17/TXD) PD1 3
- digital pin 2 (INT0) (PCINT18/INT0) PD2 4
d.p. 3 (INT1, PWM) (PCINT19/OC2B/INT1) PD3 5
digital pin 4 (PCINT20/XC(K/T0) PD4 6

Analog pins

- VCC 7
- GND 8

- A0 (PCINT0/CLKO/ICP1) PB0 14
- A1 (PCINT1/OC1A/PCINT1) PB1 15
- A2 (PCINT23/AIN1) PD7 13
- A3 (PCINT22/OC0A/AIN0) PD6 12
- A4 (PCINT21/OC0B/AIN2) PD5 11
digital pin 5 (PWM) (PCINT6/XTAL1/TOSC1) PB7 10
digital pin 6 (PWM) (PCINT7/XTAL2/TOSC2) PB8 9

- A5 (PCINT14/RESET) PC6 1

Analog pin connectors (in digital mode) work great for servos too!

Hookups for sensors. Resistive sensors are shown but Arduino analog inputs can be used with any sensor designed for a voltage output.

Pin mapping of the Atmega168 / 238 chip to the BBB (Arduino)
Many thanks to Donald Weiman for all his work whipping our schematics into shape. They are much more clear than our previous efforts.
Note that there is no danger in connecting an USB programming adapter and external power at the same time, as the USB/EXT shunt will allow only one source of power at the same time. Additionally, either power option will allow uploading of sketches to the microcontroller, as long as the USB adapter is connected to the programming header.
Troubleshooting

Symptom: No pilot light.
Disconnect power supply right away while you look for the problem.

Causes:
LED in backwards
electrolytic capacitor in backwards
voltage regulator in backwards
no power select shunt (shorting clip) on EXT or USB
no power at external jack - check power adapter & polarity
bad solder connection - check power at power jack &
power-select pins
diode in backwards
power supply connections reversed - check external supply with a multimeter
bad USB cable - check for power at BUB or FTDI cable

Procedure: check for 5 volts at power buses: at USB port, at power jack, near analog pins, at pins 7&8 of the Atmega168
If 5V is found at power bus pins, LED is in backwards or poor solder joint. If low or incorrect voltage, check diodes, voltage regulator, solder joints, power supply, chip in backwards.

Symptom: Pilot light LED on but dim or regulator gets hot.

Causes:
Wrong resistor on pilot light LED
High current draw somewhere - disconnect breadboard circuit or PRJ shunt to see if LED is restored, check current draw
Chip in backwards

Symptom: Pilot light on but program won't upload to board

Hardware Causes:
Atmega168 in backwards or not seated properly (check for pins that have "escaped the socket", seat firmly, check solder joints
Atmega168 not programmed with bootloader
bad cable
solder joint at cable connector or pins 2& 3 (check for shorts or bad (solder joints) on all pins, reheat all solder joints
wrong resonator value
wrong resistor across resonator (1M)

Procedure: if you have an oscilloscope, check for signals across resonator pins and on RX line during download.

Software/PC side causes:
drivers not installed on PC - Check Arduino->Tools->Serial Port to see if BUB / cable shows up when you plug / unplug programming adapter
check for proper chip (Atmega168 / 328) selected in Arduino->Tools->Board->Atmega168 OR 328
click RESET switch simultaneously with download attempt, if running a sketch that uses serial port heavily.

General "Cure-Alls":
Check orientation on all polarized parts, V.R., caps, diodes, V.R., socket and chip.
Check values of resistors.
Reheat all solder pads on bottom of board, look for bridges (shorts) on chip pins.
Clean PCB with toothbrush and isopropyl alcohol.
Swap cables, power supplies, chips if possible.

General Troubleshooting Ideas:
Get your meter out - you can't see electricity! Well maybe you can.
Try to isolate the problem in one system or subsystem.
Swap parts with working units.
Post questions to moderndevice.com / forum.
Inductor

Inductors (coils) act to oppose a change in current. In the BBB circuit the inductor’s role is to reduce fast-changing power-supply noise. The 15 mh (millihenry) inductor is the only surface-mount component on the board. Here’s how to mount it.

Place the inductor on the pad, hold it down by laying an Exacto knife or needlenose pliers on top of it, or just try it loose. Heat the pad, (do not touch the inductor with the soldering iron) and apply a small amount of the finest solder (.030 or less) you can find. Solder will rapidly flow onto the pad and inductor, lift the soldering iron almost immediately. Just reheat the first side quickly to insure a good solder joint.

Don’t worry if the inductor is not on perfectly straight, the electricity can’t tell the difference. Don’t overheat it either, it’s small and will solder quickly. If it’s really crooked, you can position it by quickly and alternately heating opposite ends and pushing gently with the soldering iron.

If you don’t want to fuss with the tiny inductor, just leave it out and solder up the pads as shown above. No other Arduino boards include it although the Atmega 168 datasheet recommends it, and the reduction in analog noise that it provides is fairly minor.

Resistors

1k (1000 ohms) brown-black-red
10k (10,000 Ω) brown-black-orange
1M (1,000,000 Ω) brown-black-green

Resistors are not polarized, meaning it doesn’t matter which end goes where.

Diodes

Diodes act as electrical “one-way” valves. Electricity flows in the direction of the arrow, but not the other way. They are polarized. Stripe is negative (cathode end). Think of the stripe on the diode as the stripe in the schematic. Get the stripe oriented the correct way on the board, or the project is almost guaranteed not to work.

Prepare all the resistors and diodes for inserting into pcb by bending their leads at right angles, adjacent to the component body.

Capacitors

Capacitors are components that store electrical energy (charge). There are several different technologies that are used to construct capacitors. The BBB contains ceramic capacitors, that are not polarized, and electrolytic capacitors, that are polarized, and must be inserted with the correct orientation.

LED

LED’s are diodes which emit light. They are polarized like diodes so insert them in the correct direction.

Resonator

The 16 Mhz ceramic resonator acts as a calibrated oscillator for the BBB. As you can see from the schematic, it contains a crystal element and two small capacitors. It’s symmetrical, so you can’t put it in backwards, but it is a good idea to put it in so that you can read the label.

Voltage Regulator

The voltage regulator is an integrated circuit which will limit higher input voltages to 5 volts. It will also limit the current flow in case of short circuits. The electronics industry calls the physical form an IC is packaged in a “package” or “case”, the actual IC is always a small chip embedded somewhere in the plastic. The voltage regulator provided may vary by number but is in a TO-92 case.

If you need to have more regulated power, to power a lot of high powered LED’s on a breadboard, for example, then, your board will accommodate a TO-220 package regulator, such as the LM2937 listed in the parts list, or the popular 7805. Just remember to insert it backwards as shown in figure 1.

Make sure you get the TO-92 regulator inserted in the correct orientation. It is not symmetrical so match the part outline on the board with the regulator shape.

If you don’t want to fuss with the tiny inductor, just leave it out and solder up the pads as shown above. No other Arduino boards include it although the Atmega 168 datasheet recommends it, and the reduction in analog noise that it provides is fairly minor.
Electrical Soldering for Beginners

Use a high-quality soldering iron with the sharpest point you can find. It should be rated between 20 and 25 watts.

Keep the soldering iron tinned (coated with solder) at all times. The tip should look slivery and shiny. It is important to do this as soon as a new soldering iron gets hot.

Wipe your soldering iron tip off on a wet sponge, or a copper "scrubbie", to keep it clean and shiny. Do this whenever the tip stops looking shiny or has too much solder buildup on it.

Use either leaded or "no-lead" solder but be aware no-lead solder is a little harder to use for beginners, and makes solder joints that are slightly less shiny than leaded solder.

Work in a room with some ventilation. There is a tiny bit of lead in solder fumes but the flux fumes are more of a health-hazard than the lead. Jameco sells a nice soldering iron / carbon filter combination for under $100.

Heat the pad for about a second, then apply solder to the heated pad or leads, not the soldering iron. After the solder melts and "grabs" the pad, continue heating for another second.

If you haven't gotten the solder to grab after about 4 seconds let the joint cool down before trying again. Too much heat can ruin electronic components, but most beginners err on the side of too little heat ("cold" solder joints). If the solder joint looks lumpy, or if the solder doesn't completely cover the pad, the solder joint needs more heat. Just reheat it again until you see the flux around it "simmer" a bit, and the solder grabs the pad and smoothes out.

It is a good idea to clean the solder flux off your board with a toothbrush and isopropyl (not denatured) alcohol, when you are done with your board. Most fluxes when left on the board for extended periods of time, will corrode pcb pads and traces. Additionally, fluxes are not perfect insulators, so can effect the electrical operation of your circuit.

Splash a little alcohol on the board and scrub with a toothbrush. Rinse with clean alcohol and repeat until the board looks flux-free. Dry it off a little with a paper towel or rag and have a good inspection of your solder joints, to make sure pins are not bridged (shorted) with solder, and that all the solder joints look shiny, smooth, and cover the pads completely. Questionable solder joints may be fixed simply by reheating with the soldering iron.

Power Soldering for Multiple-Kit Builders: or how to put together 10 BBB kits on Saturday and still have time to meet your friends.

Additional items required: Piece of foam rubber - antistatic pink foam is ideal, small alligator clips from Radio Shack.

We insert parts in groups and don't bend any leads to hold parts in. Once the board is flipped for soldering, the foam holds the components against the board. We put the boards together in 4 steps.

Step 1: mount the inductor, covered on page 4. You can get it straight by quickly and alternately heating either end and gently moving it.

Step 2: Insert the resistors, diodes, reset switch, LED and small (104) caps. Don't bend the leads. Cover the parts with the foam and flip the whole board, then solder it. If you are worried that a part may not be seated down against the board apply some pressure to the board while heating one pin.

Step 3: Cut the leads from the last step. Insert all the remaining parts except the 18 pin header and 2 pin header. If you have alligator clips, clip all the headers which face up, and the power jack, to the board up to the board with the small alligator clips. You'll need to pinch the "noses" of the clips flat, with pliers, so that the clips will fit between the pins.

Put the foam on top of the board and flip the whole mess so foam is now on bottom and board is upside down. Tack down one pin only on headers and socket. Solder in all pins on electrolytic caps, resonator and parts held in with clips. (Flip the board to inspect "fit" on headers and socket and adjust by heating with pressure from index finger. A thimble might be useful if you haven't burned out all the nerves in your index finger soldering, as we have. Flip and finish soldering.

Step 4: Insert the 18 pin and 2 pin header on bottom of board. Clip the headers in place with alligator clips and solder them on the top of the board.

It is a good idea to clean the solder flux off your board with a toothbrush and isopropyl (not denatured) alcohol, when you are done with your board. Most fluxes when left on the board for extended periods of time, will corrode pcb pads and traces. Additionally, fluxes are not perfect insulators, so can effect the electrical operation of your circuit.

Splash a little alcohol on the board and scrub with a toothbrush. Rinse with clean alcohol and repeat until the board looks flux-free. Dry it off a little with a paper towel or rag and have a good inspection of your solder joints, to make sure pins are not bridged (shorted) with solder, and that all the solder joints look shiny, smooth, and cover the pads completely. Questionable solder joints may be fixed simply by reheating with the soldering iron.

Power Soldering for Multiple-Kit Builders: or how to put together 10 BBB kits on Saturday and still have time to meet your friends.

Additional items required: Piece of foam rubber - antistatic pink foam is ideal, small alligator clips from Radio Shack.

We insert parts in groups and don't bend any leads to hold parts in. Once the board is flipped for soldering, the foam holds the components against the board. We put the boards together in 4 steps.

Step 1: mount the inductor, covered on page 4. You can get it straight by quickly and alternately heating either end and gently moving it.

Step 2: Insert the resistors, diodes, reset switch, LED and small (104) caps. Don't bend the leads. Cover the parts with the foam and flip the whole board, then solder it. If you are worried that a part may not be seated down against the board apply some pressure to the board while heating one pin.

Step 3: Cut the leads from the last step. Insert all the remaining parts except the 18 pin header and 2 pin header. If you have alligator clips, clip all the headers which face up, and the power jack, to the board up to the board with the small alligator clips. You'll need to pinch the "noses" of the clips flat, with pliers, so that the clips will fit between the pins.

Put the foam on top of the board and flip the whole mess so foam is now on bottom and board is upside down. Tack down one pin only on headers and socket. Solder in all pins on electrolytic caps, resonator and parts held in with clips. (Flip the board to inspect "fit" on headers and socket and adjust by heating with pressure from index finger. A thimble might be useful if you haven't burned out all the nerves in your index finger soldering, as we have. Flip and finish soldering.

Step 4: Insert the 18 pin and 2 pin header on bottom of board. Clip the headers in place with alligator clips and solder them on the top of the board.